Chapter 433

Conditional Power and Sample Size
Reestimation of Two-Sample T-Tests

Introduction

In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).

This program module computes conditional and predictive power for the case when a two-sample t-test is used to test whether the means of two populations are different. It also provides sample size reestimation to achieve a specified conditional power value.

Technical Details

All details and assumptions usually made when using a two-sample t-test continue to be in force here.

Conditional Power

The power of an experiment indicates whether a study is likely to result in useful results, given the sample size. Low power means that the study is futile: little chance of statistical significance even though the alternative hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the study has started. When this happens, the study is curtailed.

The futility of a study that is underway can be determined by calculating its conditional power: the probability of statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional power will seldom result in study curtailment very early in the study.

From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage \( k \) for rejecting a null hypothesis about a parameter \( \theta \) at the end of the study, given the observed test statistic, \( Z_k \), is computed as

\[
P_{uk}(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_K} + \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right),
\]

the general lower one-sided conditional power at stage \( k \) is computed as

\[
P_{lk}(\theta) = \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_K} - \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right),
\]

and the general two-sided conditional power at stage \( k \) is computed as

\[
P_k(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha/2} \sqrt{I_K} + \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right) + \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha/2} \sqrt{I_K} - \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right),
\]

where

- \( \theta \) = the parameter being tested by the hypothesis
- \( k \) = an interim stage at which the conditional power is computed (\( k = 1, \ldots, K - 1 \))
- \( K \) = the stage at which the study is terminated and the final test computed
- \( Z_k \) = the test statistic calculated from the observed data that has been collected up to stage \( k \)
- \( I_k \) = the information level at stage \( k \)
- \( I_K \) = the information level at the end of the study
- \( z_{1-\alpha} \) = the standard normal value for the test with a type I error rate of \( \alpha \).

For a test of a two means with null hypothesis \( H_0: \mu_1 = \mu_2 \), where \( \mu_1 \) and \( \mu_2 \) are the population means in groups 1 and 2, respectively, under the alternative hypothesis, these components are computed in Chang (2008) page 70 as

\[
\theta = \mu_2 - \mu_1 \quad \text{(the expected difference under the alternative hypothesis)}
\]

\[
Z_k = (\bar{x}_{2k} - \bar{x}_{1k}) \sqrt{\frac{1}{I_k}} \quad \text{(the } t \text{-statistic computed from the observed data)}
\]

\[
I_k = \left( \frac{\sigma_1^2}{n_{1k}} + \frac{\sigma_2^2}{n_{2k}} \right)^{-1} \quad \text{(the interim information level)}
\]

\[
I_K = \left( \frac{\sigma_1^2}{n_1} + \frac{\sigma_2^2}{n_2} \right)^{-1} \quad \text{(the final information level)}
\]
where

\[ \bar{x}_{jk} \] is the sample mean for group \( j \), estimating \( \mu_j \) at stage \( k \)

\[ I_k \] is the estimated information from the sample at stage \( k \)

\[ n_{jk} \] is the sample size in group \( j \) at stage \( k \)

\[ n_j \] is the final sample size in group \( j \)

\( \sigma_j^2 \) is the variance of group \( j \)

Computing conditional power requires you to set \( \mu_1, \mu_2, \sigma_1, \) and \( \sigma_2 \), in addition to the current test statistic value, \( Z_k \). Their values can come from the values used during the planning of the study, from similar studies, or from estimates made from the data that has emerged.

**Futility Index**

The futility index is \( 1 - P_k(\theta)\lvert_{H_1} \). The study may be stopped if this index is above 0.8 or 0.9 (that is, if conditional power falls below 0.2 or 0.1).

**Predictive Power**

Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power at stage \( k \) is given by

\[
P_{uk} = \Phi \left( \frac{Z_k \sqrt{I_K - z_{1-\alpha} \sqrt{I_k}}}{\sqrt{I_K - I_k}} \right),
\]

the general lower one-sided predictive power at stage \( k \) is given by

\[
P_{lk} = \Phi \left( \frac{-Z_k \sqrt{I_K - z_{1-\alpha} \sqrt{I_k}}}{\sqrt{I_K - I_k}} \right),
\]

and the general two-sided predictive power at stage \( k \) is given by

\[
P_k = \Phi \left( \frac{Z_k \sqrt{I_K - z_{1-\alpha/2} \sqrt{I_k}}}{\sqrt{I_K - I_k}} \right) + \Phi \left( \frac{-Z_k \sqrt{I_K - z_{1-\alpha/2} \sqrt{I_k}}}{\sqrt{I_K - I_k}} \right),
\]

with all terms defined as in the equations for conditional power.

**Sample Size Reestimation**

As Chang (2014) points out, after an interim analysis, it is often desirable to recalculate the target sample size using updated values for various nuisance parameters such as the variance. This process is known as sample size reestimation.

One method of calculating an adjusted sample size estimate is to search for the sample size that results in a predetermined value of conditional power. PASS conducts a binary search using the conditional power as the criterion. The result is called the target sample size.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Conditional Power or Sample Size Reestimation.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate conditional power directly. To find appropriate values of sample size, a binary search is made using an iterative procedure until an appropriate value is found.

Test

Alternative Hypothesis

Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite, specifying the alternative is all that is needed.

When you choose a one-sided option, you must be sure that the values of μ1 and μ2 match your choice.

Conditional Power and Alpha

Conditional Power

Enter one or more values for the conditional power that is to be attained by the sample size search.

*Conditional power* is the probability of rejecting a false null hypothesis given the data that has been obtained so far. It is a function of the effect size and the data that have been collected.

The valid range is between 0 to 1. Typically, values over 0.70 are considered high enough to continue a study, while values below 0.10 considered grounds for curtailing the study.

You can enter a single value such as 0.80 or a series of values such as 0.80 0.85 0.90 0.95 or 0.7 to 0.97 by 0.05.

Alpha

This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025 for one-sided tests.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size

**N1 (Group 1 Target Sample Size)**
Enter one or more values of the target sample size of group 1, the total number of subjects planned for this group. This value must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

**N2 (Group 2 Target Sample Size)**
Enter a value (or range of values) for the target sample size of group 2 or enter Use R to calculate N2 from N1. You may enter a range of values such as 10 to 100 by 10.

- Use R
  If Use R is entered here, N2 is calculated using the formula
  \[ N2 = \lceil R(N1) \rceil \]
  where R is the Sample Allocation Ratio and the operator \( \lceil \) is the first integer greater than or equal to Y. For example, if you want \( N1 = N2 \), select Use R and set \( R = 1 \).

**R (Sample Allocation Ratio)**
Enter a value (or range of values) for R, the allocation ratio between samples. This value is only used when N2 is set to Use R.

When used, N2 is calculated from N1 using the formula: \( N2 = \lceil R(N1) \rceil \) where \( \lceil \) is the next integer greater than or equal to Y. Note that setting \( R = 1.0 \) forces \( N2 = N1 \).

**n1k (Group 1 Sample Size at Look k)**
Enter the group 1 sample size obtained through look k. If this value is greater than N1, the value of N1 is increased to this amount.

**n2k (Group 2 Sample Size at Look k)**
Enter the group 2 sample size obtained through look k. If this value is greater than N2, the value of N2 is increased to this amount.

**Equal Sample Sizes**
If \( n1k \) is entered here, \( n2k \) is set equal to \( n1k \).

**Effect Size – Mean Difference**

**µ1 (Mean of Group 1)**
Enter a value for \( \mu_1 \), the mean of group 1. The power and sample size of the study are based on the difference between the mean of group 2 and this mean, \( \delta_1 = \mu_2 - \mu_1 \). The null hypothesis assumes that \( \mu_1 = \mu_2 \). The alternative hypothesis assumes that these values are different. This difference, \( \delta_1 \), is the minimum detectable difference.

Usually, the values of \( \mu_1 \) and \( \mu_2 \) that were used to plan the study are used here.

You may enter a range of values such as '10 20 30' or '0 to 100 by 25'.

If you have selected a one-sided alternative hypothesis, you must be sure that the values of \( \mu_1 \) and \( \mu_2 \) match the hypothesis direction.
μ₂ (Mean of Group 2)

Enter a value for μ₂, the mean of group 2. The power and sample size of the study are based on the difference between this mean and the mean of group 1, δ₁ = μ₂ - μ₁. The null hypothesis assumes that μ₁ = μ₂. The alternative hypothesis assumes that these values are different. This difference, δ₁, is the minimum detectable difference.

Usually, the values of μ₁ and μ₂ that were used to plan the study are used here.

You may enter a range of values such as '10 20 30' or '0 to 100 by 25'.

If you have selected a one-sided alternative hypothesis, you must be sure that the values of μ₁ and μ₂ match the hypothesis direction.

Effect Size – Standard Deviations

σ₁ (Standard Deviation of Group 1)

Enter a value for σ₁, the standard deviation of group 1. This value is controversial. Some think you should enter the value used in planning the study. Others think you should use the value estimated from the data obtained so far. Still others think you should use a confidence limit for σ₁ created from the current sample.

You can enter a range of values such as 1 2 3 or 1 to 5 by 1.

Press the σ button to the right to load the Standard Deviation Estimator window.

σ₂ (Standard Deviation of Group 2)

Enter a value for σ₂, the standard deviation of group 2. This value is controversial. Some think you should enter the value used in planning the study. Others think you should use the value estimated from the data obtained so far. Still others think you should use a confidence limit for σ₁ created from the current sample.

You can enter a range of values such as 1 2 3 or 1 to 5 by 1.

Equal Variance

Enter ‘σ₁’ to set σ₂ = σ₁.

Effect Size – Current Test Statistic

Zk (Current Test Statistic)

Enter the value of the t-statistic calculated from the data obtained so far. This value may be positive or negative. Usually, the t-statistic ranges between -5 and 5.
Example 1 – Computing Conditional Power

Suppose a study has been planned to detect a mean change of 2 at an alpha of 0.05 using a two-sided t-test. The sample size is 60. The standard deviations are expected to be about 4. An interim analysis is run after half the data have been collected. This analysis yields a t-test value of 2.12. This value was obtained by transforming the t-test p-value using the inverse normal.

The data monitoring board would like to have the conditional power calculated for a mean change, \( \mu_2 - \mu_1 \), of 0.5, 1, 1.5, and 2.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Conditional Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>H1: ( \mu_2 - \mu_1 \neq 0 ) (Two-Sided)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N1 (Group 1 Target Sample Size)</td>
<td>60</td>
</tr>
<tr>
<td>N2 (Group 2 Target Sample Size)</td>
<td>Use R</td>
</tr>
<tr>
<td>R (Sample Allocation Ratio)</td>
<td>1.0</td>
</tr>
<tr>
<td>n1k (Group 1 Sample Size at Look k)</td>
<td>30</td>
</tr>
<tr>
<td>n2k (Group 2 Sample Size at Look k)</td>
<td>n1k</td>
</tr>
<tr>
<td>( \mu_1 ) (Mean of Group 1)</td>
<td>0</td>
</tr>
<tr>
<td>( \mu_2 ) (Mean of Group 2)</td>
<td>0.5 1 1.5 2</td>
</tr>
<tr>
<td>( \sigma_1 ) (Standard Deviation of Group 1)</td>
<td>4</td>
</tr>
<tr>
<td>( \sigma_2 ) (Standard Deviation of Group 2)</td>
<td>( \sigma_1 )</td>
</tr>
<tr>
<td>Zk (Current Test Statistic)</td>
<td>2.12</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Cond Power</th>
<th>Pred Power</th>
<th>Target Sample Sizes</th>
<th>Current Sample Sizes</th>
<th>Means</th>
<th>Diff</th>
<th>Std Dev</th>
<th>Test Stat</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.43342</td>
<td>0.85040</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>0.5</td>
<td>0.5</td>
<td>4.0</td>
</tr>
<tr>
<td>0.62417</td>
<td>0.85040</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>1.0</td>
<td>1.0</td>
<td>4.0</td>
</tr>
<tr>
<td>0.78831</td>
<td>0.85040</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>1.5</td>
<td>1.5</td>
<td>4.0</td>
</tr>
<tr>
<td>0.90055</td>
<td>0.85040</td>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>2.0</td>
<td>2.0</td>
<td>4.0</td>
</tr>
</tbody>
</table>

References

Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the effect size.
N1|N2 are the target sample sizes of groups 1 and 2, respectively.
n1k|n2k are the sample sizes of groups 1 and 2, respectively, obtained through stage k.
μ1 is the mean of group 1.
μ2 is the mean of group 2.
δ1 = μ2 - μ1 is the actual difference to detect under the alternative hypothesis at which conditional power is calculated.
σ1|σ2 are the standard deviations of groups 1 and 2, respectively.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped because there is little chance of achieving statistical significance.

Summary Statements
The first 30 of 60 subjects in group 1 and 30 of 60 subjects in group 2 achieve 43.342% conditional power to detect a difference of δ1 = μ2 - μ1 = 0.5 - 0.0 = 0.5 using a two-sided T-test with group 1 standard deviation of σ1 = 4.0, group 2 standard deviation of σ2 = 4.0, and a significance level of alpha = 0.050. The value of the test statistic from data that have emerged so far is Zk = 2.120. The futility index is 0.56658.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and μ2.
Example 2 – Validation

We could not find an example of a conditional power calculation for a two-sample t-test in the literature. Since the calculations are relatively simple, we will validate the calculation of the first scenario \((\theta = 0.5)\) of Example 1 by hand.

In this case

\[
I_k = \left( \frac{\sigma_1^2}{n_{1k}} + \frac{\sigma_2^2}{n_{2k}} \right)^{-1} \quad I_K = \left( \frac{\sigma_1^2}{n_1} + \frac{\sigma_2^2}{n_2} \right)^{-1}
\]

\[
= \left( \frac{16}{30} + \frac{16}{30} \right)^{-1} = \frac{1}{2} = 0.9375 \quad = \left( \frac{16}{60} + \frac{16}{60} \right)^{-1} = \frac{1}{2} = 1.875
\]

\[
P_k(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{\alpha/2} \sqrt{I_K} + \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right) + \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha/2} \sqrt{I_K} - \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right)
\]

\[
= \Phi \left( \frac{2.12 \sqrt{0.9375} - (1.9599640) \sqrt{1.875} + 0.5(1.875 - 0.9375)}{\sqrt{1.875 - 0.9375}} \right) + \Phi \left( \frac{-2.12 \sqrt{0.9375} - (1.9599640) \sqrt{1.875} - 0.5(1.875 - 0.9375)}{\sqrt{1.875 - 0.9375}} \right)
\]

\[
= \Phi(-0.1676848) + \Phi(-5.3759305) = 0.4334156 + 0.000000 = 0.4334156
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

**Option** | **Value**
--- | ---
**Design Tab** | **Conditional Power**
Solve For | Conditional Power
Alternative Hypothesis | H1: \( \mu_2 - \mu_1 \neq 0 \) (Two-Sided)
Alpha | 0.05
N1 (Group 1 Target Sample Size) | 60
N2 (Group 2 Target Sample Size) | Use R
R (Sample Allocation Ratio) | 1.0
n1k (Group 1 Sample Size at Look k) | 30
n2k (Group 2 Sample Size at Look k) | n1k
\( \mu_1 \) (Mean of Group 1) | 0
\( \mu_2 \) (Mean of Group 2) | 0.5
\( \sigma_1 \) (Standard Deviation of Group 1) | 4
\( \sigma_2 \) (Standard Deviation of Group 2) | \( \sigma_1 \)
Zk (Current Test Statistic) | 2.12
Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Target Sample Sizes</th>
<th>Current Sample Sizes</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Test Stat</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>60</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>0.5</td>
<td>0.5</td>
</tr>
</tbody>
</table>

The conditional power of 0.43342 matches the value calculated by hand.
Example 3 – Sample Size Reestimation Example

Suppose a study has been planned to detect a mean change of 2 at an alpha of 0.05 using a two-sided t-test. The original target sample size was 60. The standard deviations were expected to be about 4. An interim analysis was run after half the data were collected. This analysis yielded a z-test value of 2.12. This value was obtained by transforming the t-test p-value using the inverse normal. The standard deviations were found to be 6.7.

The data monitoring board would like to recalculate the sample size for a mean change of 1.5, a conditional power of 0.8, and a standard deviation of 6.7.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size Reestimation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>H1: ( \mu_2 - \mu_1 \neq 0 ) (Two-Sided)</td>
</tr>
<tr>
<td>Conditional Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N2 (Group 2 Target Sample Size)</td>
<td>Use R</td>
</tr>
<tr>
<td>R (Sample Allocation Ratio)</td>
<td>1.0</td>
</tr>
<tr>
<td>n1k (Group 1 Sample Size at Look k)</td>
<td>30</td>
</tr>
<tr>
<td>n2k (Group 2 Sample Size at Look k)</td>
<td>n1k</td>
</tr>
<tr>
<td>( \mu_1 ) (Mean of Group 1)</td>
<td>0</td>
</tr>
<tr>
<td>( \mu_2 ) (Mean of Group 2)</td>
<td>1.5</td>
</tr>
<tr>
<td>( \sigma_1 ) (Standard Deviation of Group 1)</td>
<td>6.7</td>
</tr>
<tr>
<td>( \sigma_2 ) (Standard Deviation of Group 2)</td>
<td>( \sigma_1 )</td>
</tr>
<tr>
<td>Zk (Current Test Statistic)</td>
<td>2.12</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Cond Power</th>
<th>Pred Power</th>
<th>Target Sample Sizes</th>
<th>Current Sample Sizes</th>
<th>Means</th>
<th>Mean Diff</th>
<th>Std Dev</th>
<th>Test Stat</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80000</td>
<td>0.93153</td>
<td>203</td>
<td>203</td>
<td>30</td>
<td>30</td>
<td>0.0</td>
<td>1.5</td>
<td>1.5</td>
<td>6.7</td>
</tr>
</tbody>
</table>

Notice that the target sample size has increased from 60 per group (N = 120), to 203 per group (N = 406).